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Diseno de un sistema basico utilizando MicroBlaze

Introduccion

En este documento se muestra como crear un sistema basico con el procesador Microblaze utilizando la
herramienta Xilinx Platform Studio (XPS). Este sistema se implementa en una placa de desarrollo Nexys 2.

Objetivos

e Crear un proyecto en XPS utilizando el Base System Builder (BSB)
e Crear un disefio simple, utilizando IP disponible en el Embedded Development Kit (EDK)

Procedimiento

El proposito de este documento es servir de apoyo para implementar el hardware y software de un sistema
basico basado en un procesador softcore de 32 bits (MicroBlaze).

Se utilizar4 la herramienta BSB (Base System Builder) del entorno XPS para crear un sistema bésico con los
siguientes elementos e IP (Figura 1.1):
e MicroBlaze (version 7.30.b)
PLB_MDM
LMB BRAM controlador para BRAM
BRAM
UART para comunicacion serie
GPIO para comandar LEDs

Figura 1.1: Sistema basico

Esta guia cuenta con 3 etapas:
e Crear un proyecto usando la herramienta Base System Builder
¢ Analizar el proyecto creado
e Probar el proyecto en hardware

En cada etapa hay instrucciones generales (indicadas por el simbolo <® ). Estas instrucciones generales
dan una idea global de la tarea a realizar. A continuacién se indican instrucciones paso a paso mas
detalladas con figuras ilustrativas. De acuerdo al conocimiento y experiencia, pueden saltarse las
instrucciones paso a paso e ir directamente a la siguiente instruccion general.
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Crear el proyecto utilizando Base System Builder m

®  Iniciar el entorno Xilinx Platform Studio (XPS) y crear un nuevo proyecto. Usar la
herramienta Base System Builder para generar un sistema basico con MicroBlaze y una
aplicacion que verifica la memoria. Implementar el sistema en la placa de desarrollos Nexys2.

1.1. Iniciar XPS seleccionando Inicio » Todos los Programas » Xilinx Design Tools » ISE Design Suite
14.7 » EDK » Xilinx Platform Studio.

1.2. Seleccionar Create New Project Using Base System Builder para iniciar el wizard. Se puede llegar al
mismo dialogo por medio de File » New BSB Project

o ™y
2 Create New XPS Praject Using BSE Wiza 5

Mew Project

Project File |

Select an Interconnect Type

@ AXI System
AXI is an interface standard recently adopted by Xilinx as the standard interface used for all current and

future versions of Xilinx IP and tool flows. Details on AXI can be found in the AXI Reference Guide on
wilina. com.

I PLB System
FLB is the legacy bus standard used by Xilinx that supperts current FPGA families, induding Spartans and

VirtexG. PLB IP wil not support newer FPGA families, so is not recommend for new designs that may

migrate to future FPGA families. Details on PLE can be found in the PLBv46 Interface Simplifications
document on xilinx. com.

Select Existing .bsh Settings File(saved from previous session)

Browse ...

Set Project Peripheral Repository Search Path

Brawse ...

OK ] ’ Cancel l

Figura 1.2: Creacion de un nuevo proyecto utilizando Base System Builder

1.3. Con el botén Browse seleccionar la ubicacion del nuevo proyecto, luego presionar Open para abrir el
directorio. Luego presionar el botén Save (Figura 1.3) para guardar el archivo system.xmp.

1.4. Seleccionar PLB System.

1.5. Obtener el Board Support Package para la placa Nexys2 y guardarlo localmente. Con el boton Browse

de Set Project Peripheral Repository Search Path seleccionar el subdirectorio Lib. Finalmente
presionar OK.
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1% - 3 BSE Wizarc . |

MNew Project

Project File | D:\MyS\aboratorios'Lab 1\system. xmp

Select an Interconnect Type

() AXI System

AXIis an interface standard recently adopted by Xilinx as the standard interface used for all current and
future versions of Xilinx IP and tool flows. Details on AXI can be found in the AXI Reference Guide on
wilinz. com.

@ PLB System

PLB is the legacy bus standard used by Xilinx that supports current FPGA families, induding Spartans and
Virtexs. PLB IP will not support newer FPGA families, so is not recommend for new designs that may
migrate to future FPGA families. Details on PLB can be found in the PLBv46 Interface Simplifications
document on xilinx. com.

Select Existing .bsb Settings File(saved from previous session)

Set Project Peripheral Repository Search Path

D:WMyS Mexys2_BSB_Support_v_3_0\lib

Figura 1.3: Establecimiento del directorio del proyecto

1.6. En el Nuevo didlogo Welcome to Base System Builder seleccionar la opcion | would like to create a
new design y presionar Next.

1.7. En el didlogo Board Selection, especificar la siguiente configuracion (Figura 1.4) y presionar Next.

e Board Vendor: Digilent
¢ Board Name: Nexys 2-500 Board
e Board Revision (Verify on board): C

Welcome Board System Processor Peripheral Cache Summary
/]

Board Selection
Select a target development board.

Board
@ Iwould like to create a system for the following development board

Board Vendor | Digilent |Z|
Board Name Mexys 2-500 Board u
Board Revision |C |Z|

() Iwould like to create a system for a custom board

Board Information

Architecture Device Package Speed Grade
spartan3e XC35500E FG320 -4
|:| Use Stepping

Reset Polarity |Active High

Figura 1.4: Seleccion de la placa de desarrollo

1.8. En el didlogo System Configuration, dejar la opcion por defecto Single-Processor System (Figura 1.5)
y presionar Next.
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i iﬂase System Buildel EIL |

Welcome Board System Processor Peripheral Cache Summary
! /]

System Configuration
Configure your system.

(@ Single-Processor System () Dual-Processor System
Select this option to create a design with a single processor. This Wizard Select this option to create a design with two processors. This Wizard
will let you configure the processor, the peripheral set and some major will let you select the types of processors, peripherals unique to each
configuration parameters for the peripherals. processor, and peripherals shared by the processors,

Processor 1 Peripherals

Processor 1
RS232 GPIO

Processor 1

Shared Peripherals

Mailbox  Mutex

Processor 1 Peripherals

RS232 GFIO

Processor 2 Peripherals

DDR EMAC

Figura 1.5: Configuracién del sistema

1.9. En el dialogo Processor Configuration (Figura 1.6), dejar la configuracién por defecto (ver mas abajo) y
presionar Next.

¢ Reference Clock Frequency: 50 MHz (Este es el oscilador externo de la placa de desarrollos; se
utilizara para generar la temporizacion del procesador y los
buses).

Processor type: MicroBlaze

System Clock Frequency-bus Clock Frequency: 50 MHz

Local Memory: 8 KB

Debug Interface: On-Chip H/W debug module

i iﬂase System Builde % | |

Welcome Board System Processor Peripheral Cache Summary

Processor Configuration

Configure the processor(s).

Reference Clock Frequency | 50,00 MHz

Processor 1 Configuration

Processor Type MicroBlaze IZ|
System Clock Frequency |50.00 |Z| MHz
Local Memory 3KB IZ|
Debug Interface On-Chip HW Debug Module

[ Enable Floating Point Unit

Figura 1.6: Configuracion del procesador

‘» Seleccionar y configurar a LEDs_8Bit y RS232_PORT como dispositivos externos, a los
controladores dimb y ilmb como controladores internos. Generar las aplicaciones de testeo
de memoria y testeo de periféricos mediante el script de enlazado (linker script).

1.10. En el didlogo Peripheral Configuration, seleccionar RS232_PORT y LEDs_8Bit como periféricos
externos, segln se muestra a continuacion, quitar los periféricos “Push_Buttons”, “SSG_Decoder”,
“Digilent_USB” y “Switches” de Processor 1 (MicroBlaze) Peripherals. Los controladores dimb y
ilmb no se pueden quitar porque son de uso interno del procesador. En este punto se podria utilizar
Add para agregar periféricos. En la siguiente practica se vera otro método para agregarlos al sistema.
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| 2 Base Systemn Builde

Welcome

Board

System

Processor Peripheral Carche Summary

Peripheral Configuration
To add a peripheral, drag it from the "Available Peripherals™ to the processeor peripheral list, To change a core parameter, dick on the peripheral.

Available Peripherals

E} In

Peripheral Mames
=10 Devices

- Push_Buttons_3Bit
- Switches_8Bit

- 5sg_Decoder 0

- Digilent_Ush_Epp
- mem_bus_muzx_0
ternal Peripherals

- |lmb_bram_if_cntlr
- xps_bram_if_cntlr
- xps_timebase_wdt
- xps_timer

Add =

< Remove

Processor 1 (MicroBlaze) Peripherals

Select Al

Core Parameter
INTEL_FLASH
Core: xps_mch_emc
LEDs_BBit
Core: xps_gpio
Micron_RAM
Core: xps_mch_emc

R5232_PORT

RS232 PORT xps_uartlite E
Parity Mone E
Use Interrupt [l

dimb_cntlr
Cores Imb_bram_if_cntir

ilmb_cntlr

Core: Imb_bram_if_cntir

Figura 1.7: Configuracion de periféricos

1.11. Presionar Next para pasar al dialogo Cache Configuration, no seleccionar nada y presionar Next.

1.12. Verificar la configuracion en el dialogo Summary (Figura 1.8) y presionar Finish.
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Processor Peripheral

Summary

Below is the summary of the system you are creating.

System Summary

Core Mame Instance Mame Base Address High Address

icroblaze 0
IMTEL_FLASH
LEDs_BBit

(082000000
(0:E1400000
(03000000
(34000000
000000000
0:00000000

0xB2FFFFFF
0xB140FFFF
0xB3FFFFFF
0xB400FFFF
0x00001FFF
0+00001FFF

xps_mch_emc
- Xps_gpio
> xps_mch_emc Micron_RAM
> xps_uartlite R5232_PORT
- Imb_bram_if_cntlr dlmb_cntlr
Imb_bram_if_cntlr ilmb_cntlr

File Location

£ Overall

- DAMyS\Laboraterios\Labl\system.xmp
D\MySiLaboraterioshLabl\system.mhs
DMy S\ Laboratorios'\Labl\data'systern.ucf
D\MyShiLaboratoriosh Lablhetc\fast_runtime.opt
DMy S Laboratorios\Labl\etc\download.crnd
D\MyShiLaboratoriosh Lablhetc\bitgen.ut

Save Base System Builder (.bsb) Settings File

D \MyS'Laboratorios\Lab 1\system.bsb

1.13. Aparece una vista del sistema (Figura 1.9), mostrando los periféricos y buses que se utilizan y su

<gack | [ Einish

]’ Cancel

Figura 1.8: Didlogo System Summary

conexionado.
LLP -ﬂ Bus Interfaces | Ports | Addresses |

rél rél Ié Mame Bus Mame IP Type IP Version

- dimb 1r Imb_v10 200.b

- iimb 1r Imb_v10 200.b

o o 1r plb_vi6 1.05.a

B microblaze O ir microblaze  8.50.c

T—p - Imb_bram 1r bram_block 1.00.a

o k& - dimb_cntlr ir Imb_bram _i... 3.10.c

A [ ilmb_entlr 1 Imb_brar_i.. 310.c

3 B INTEL_FLASH 1r xps_mch_e.. 3.0l.a

e - Micron_RAM 7 wps_mch_e.. 3.0l.a

t - mdm 0 1} mdm 210.a

;7 (- LEDs_BBit 1r xps_gpio 2.00.a

& ——|| B R5232 PORT 7 xps_uartlite  1.02.a

- clock_gener... 7 clock_gene.. 403.a

- mem_bus ... 1} mem_bus ... 1.00.a

- PFOC_SY5_IEu 7 proc_sys_re.. 3.00.a

Figura 1.9: Vista del sistema
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Analisis del harware | Paso 2 |

Seleccionar la pestafia correspondiente a “Graphical Design View” y analizar los
componentes del sistema y sus interconexiones. En la pestaiia “System Assembly View”
analizar el detalle de las conexiones del sistema.

2.1. Seleccionar la pestafa “Graphical Design View”. Observar los diferentes componentes del sistema y sus
interconexiones (se puede utilizar la tecla Ctrl y la rueda del mouse para realizar zoom sobre la vista).

R

Figura 1.10: Vista de diagrama en bloques del proyecto generado

2.2. En la vista System Assembly presionar el botéon + y observar el detalle de las conexiones del bus del
sistema.
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Bus Interfaces | Ports | Addresses |

LLP
I;' rél Iﬁ M Bus Mame IP Type IP Version
~dimb “®Botén a presionar 1 Imb_v10 2.00.b
r—— | B 11 Imb_v10 2.00.b
foo— e T 11 r plb_vi6 1.05.a
- microblaze O 1r microblaze  8.50.c
o - DLMB dimb =
| - ILMB ilmb [=]
--DPLB mb_plb =
:: -~ IPLB mb_plb [=]
- DKCL microblaze 0 D...
- I{CL microblaze O IX...
— - DEBUG microblaze_... E|
- TRACE  microblaze O T...
-~ INTERR... Mo Connecti... [
=1 Imb_bram 1} bram_block 1.00.3
§ ~-PORTA  ilmb_port [=]
j *-PORTE  dimb_port =
B dimb_cntlr T Imb_bram_i.. 3.10.c
e - SLMB dlmb =
- BRAM_.. dlmh_port
=} ilmb_cntir 1} Imb_bram_i... 3.10.c
- - SLMB ilmk [=]
- BRAM_... dmb_port
= INTEL_FLASH 1} xps_mch_e.. 30L.a
. - SPLB mb_plb [«
(=]
[=]

T = Micron_RAM 1} xps_mch_e.. 30Ll.a
3 . L-SPLB mb_plb
T = mdm 0 r mdm 210.a
3 . -SPLB mb_plb
L 1|\ -MBDEB.. microbigze 0.
. XMTC mdm_ 0 XMTC
E\‘ LEDs_8B1 1r xps_gpio 2.00.3

i - 3PLB mb_plb [

El- R5232 PORT ir xps_uvartlite  1.02.a
o — | i “SPLB mb_plb =

é----ciack_gener... 1} clock_gene.. 4.03.a

o mem_bus_ .. r mem_bus_.. 1.00.a

o PPOC_SYS_TE... 1r proc_sys_re.. 3.00.a

Figura 1.11: Conexiones del bus

2.3. Seleccionar la pestafia Ports y expandir la vista. Aqui es donde se pueden realizar conexiones internas y
externas de periféricos. Si no puede encontrar la columna Net haga click en el boton derecho del Mouse
sobre Connected Port para ver las opciones disponibles y elegir Net.
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| Bus Interfaces | Ports | Addresses | [L_;][_I
MName Connected Port Met Direction Range Class Frequency(Hz) Reset Polarity
pga 0. X LEDs_8Bit::[gpio_0]:GPIO_I0_O # fpga_0_LEDs_8Bit GPIO IO_.. [+ 0 =] (@77 MNOME (=]
fpga_0 R5232 POR... R5232_PORT:[uart_0]:RX # fpga_0_RS232_PORT_R¥_pin [«]1 [=] MNOME [=]
fpga_0 R5232 POR... R5232_PORT:[uart 0]:TX # fpga 0_RS232 PORT_TX pin [+ 0 (=] MNOME (=]
foga_ 0 clk I sys_cl.. clock_generator 0:CLEKIN _{: CLK_ S z 1 z CLK z 50000000
fega_0_mem_bus_... mem_bus_mux_U::[mem_bus_m._,{: fpga_0_mem_bus_mux 0_D.. [+]I0 (=] [@:15 MNOMNE (=]
foga_0 mem bus_... mem_bus_mux_ﬂ::[mem_bus_m._{ fpga_0_mem_bus_mux_0_FL... z a z MOME z
fega_0 mem_bus._... mem_bus_mux_U::[mem_bus_m._,{: fpga_0_mem_bus_mux_0_FL... z 0] z MNOMNE z
fega_0 mem_bus_... mem_bus_mux_(]::[mem_bus_m._.{ fpga_0_rmem_bus_mux_0_M... z 0] z [0:23] MNOMNE z
fega_0 mem_bus._... mem_bus_mux_U::[mem_bus_m._,{: fpga_0_rmem_bus_mux 0_M... z 0] z MNOMNE z
fega_0 mem_bus_... mem_bus_mux_(]::[mem_bus_m._.{ fpga_0_rmem_bus_mux_0_M... z 0] z MNOMNE z
fega_0 mem_bus._... mem_bus_mux_U::[mem_bus_m._,{: fpga_0_rmem_bus_mux 0_RA.. z 0] z [0:1] MNOMNE z
fega_0 mem_bus_... mem_bus_mux_(]"[mem_bus_m._.c_?; fpga_0_rmem_bus_mux_0_RA.. z 0] z MNOMNE z
fega_ 0 rst 1 sys rs.. :Jlrooccli;?r:TrZ;aeii(rl::E;d_Res e <7 sys_rst s L I L RST L 1 |z|
- dimb
LMB_Clk clock_generator_0:CLKOUTO ;_f: clke_50_0000MHz E|I CLK
SY5_Rst proc_sys_reset_(]::Bus_Struct_Res_a_C: sys_bus_reset E|I RST
= ilmb
LMB_Clk clock_generator_0:CLKOUTO _{: clk_50_0000MHz E|I CLK
SYS_Rst proc_sys_reset_ﬂ::Bus_Struct_Resg: sys_bus_reset E| I RST
= mb_plbh
PLE_Clk clock_generator_0:CLKOUTO ;_f: clke_50_0000MHz E|I CLK
SY5_Rst proc_sys_reset_(]::Bus_Struct_Res_a_C: sys_bus_reset E|I RST
Bus_Error_Det # No Connection [=l0O INTERRUPT
=1 microblaze 0

Figura 1.12: Puertos

2.4, Seleccionar la pestafia Addresses. Aqui es donde se puede asignar o cambiar el rango de direcciones de
los componentes del sistema.

+| Bus Interfaces I Ports | Addresses |

Instance Base Mame Base Address High Address Size Bus Interface(s) Bus Mame Lock

=-imicroblaze 0's Address Map
dimb_cntlr C_BASEADDR 000000000 0x00001FFF 8K [=] SLMB dimb 0
ilmb_cntlr C_BASEADDR 0=00000000 0x00001FFF 8K [=] SLME ilmb =
LEDs 8Bit C_BASEADDR 0x81400000 0xB8140FFFF 64K [=] SPLB mb_plb [l
INTEL_FLASH C_MEMO_BASE... 0x82000000 0xB82FFFFFF 16M [ SPLB mb_plb =
Micron_RAM C_MEMO_BASE... 0x83000000 0xB3FFFFFF 16M [=] SPLB mb_plb ]
R5232_PORT C_BASEADDR 084000000 0xB8400FFFF 64K [=] SPLB mb_plb 0
mdm_{ C_BASEADDR 0xB84400000 0xB440FFFF 64K [=] SPLB mb_plb 0

Figura 1.13: Vista de la asignacion de direcciones

Completar el diseio

Ejecutar Platgen para generar la netlist y ejecutar las herramientas de implementacién para
generar el bitstream.

3.1. Ejecutar la herramienta PlatGen seleccionando Hardware » Generate Netlist o presionando el botdn

en la barra de herramientas.

Nota: Se generaran los directorios implementation, hdl y synthesis. Los perifericos generados y la netlist
del sistema junto system.bmm seran colocados en el directorio implementation.

3.2. Generar el bitstream seleccionando Hardware » Generate BitStream o seleccionando el botén f enla
barra de herramientas.

Nota: Este punto puede demandar mas de 10 minutos, dependiendo de la maquina utilizada.

3.3. Seleccionar la pestafa Design Summary. Alli hay un resumen de la informaciéon de implementacién del
disefio, reportes y mensajes. Hay informacién especifica respecto a la FPGA usada y mensajes de las
distintas herramientas de software utilizadas. Los paneles del lado izquierdo permiten controlar la
informacién que se muestra en el panel derecho.
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Generar en SDK la aplicacién para verificar la memoria Paso 4

Iniciar SDK desde XPS, generar el proyecto de prueba de la memoria con default software
platform project.

4.1. Iniciar SDK seleccionando Project » Export Hardware Design to SDK ... desde XPS.

4.2. Seleccionar el boton Export & Launch SDK con la configuracion por defecto (la opcion Include
bitstream and BMM file marcada).

4.3. En la ventana Select a workspace navegar hasta ...\lab1\SDK\SDK_Export y presionar OK.

4.4. En SDK seleccionar File » New P Other... y en el siguiente diadlogo, dentro de la carpeta Xilinx,
seleccionar Application Project y luego presionar Next.

4.5. En el didlogo Application Project completar el campo Project name. Presionar Next.

4.6. En el didlogo Templates seleccionar Memory Tests y presionar Finish. En la figura 1.14 se puede
observar el resultado de la compilacion.

[Z/ Problems | ¥ Tasks | El Console &2 = Properties| & Terminal 4L 4 | =N ||| 2B~y -=0
CDT Build Conscle [memory_test 0]

elfcheck memory_test_@.elf -hw ../../Labl_hw_platform/system.xml -pe microblaze_ 8 |tee -
"memory_test_8.elf.elfcheck”

elfcheck

Xilinx EDK 14.7 Build EDK_P.28131@13
Copyright (c) 1995-2812 Xilinx, Inc. All rights reserved.

Command Line: elfcheck -hw ../../Labl_hw_platform/system.xml -pe microblaze_@
memory_test_@.elf

ELF file : memory_test_@.elf
elfcheck passed.
"Finished building: memory_ test_@.elf.elfcheck’

m

@3:32:38 Build Finished (took 3s5.887ms)

Figura 1.14: Resultado de la compilacion

Verificacién en hardware | Paso 5 |

Conectar y encender el kit. Establecer una conexién serie utilizando algin Terminal.
Configurar la FPGA vy verificar el correcto funcionamiento.

5.1. Conectar y encender el kit Nexys 2.

5.2. Dentro del SDK seleccionar la pestafia Terminal 1 (si no es visible seleccionar Window » Show view »
Terminal).

Nota: puede ser utilizado cualquier programa que permita una conexion serie.

5.3. Presionar el botéon “Connect” para la conexién, seleccionar el puerto COM apropiado y configurar los
diferentes parametros de la siguiente manera:

e Connection Type: Serial
e Baud Rate: 9600
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e Data bits: 8

e  Stop bits: 1

e Parity: None

e  Flow control: None

(2! Problems | ¥ Tasks | B Console |2 Properties B I Eﬁl - - ="

Mo Connection Selected

Botén Connect

Figura 1.15: Ubicacion del boton Connect

5.4. Seleccionar en el SDK Xilinx Tools » Program FPGA.

5.5. Seleccionar con el botén drop-down el archivo memory_test_0.elf

5.6.

5.7.

5.8.

Program FPGA

[z
Program FPGA
Specify the bitstream and the ELF files that reside in BRAM memory

Hardware Configuration
Hardware Specification: D:\MyS\Laboratorios\Lab1\SDK\SDK_ExportiLabl_hw_platform'system.xml
Bitstrearn:  system.bit Search...

BMM File:  system_bd.bmm Search...

Software Configuration
Processor ELF File to Initialize in Block RAM
microblaze_0 DMyShLaboratoriosiLab1\SDENSDE_Exportimemon ~
bootloop

Iy MWhySyLaboratorios\ Lab1\ SDENSDE_Exportymemory_test 0\Debughmemol
Browse..

@

Figura 1.16: Seleccion de la aplicacion

Presionar Program.

El archivo memory_test_0.elf y el system.bit se combinan en otro archivo denominado download.bit
que es el que efectivamente configura la FPGA.

Nota: en el caso de aparecer un mensaje de error seleccionar Xilinx Tools » Configure JTAG Settings
y en el campo Type del JTAG Cable seleccionar Digilent USB Cable. \olver a repetir el paso anterior. Si
el error persiste se debera utilizar la herramienta Digilent Adept para transferir el archivo de
configuracién download.bit.

En la herramienta Digilent Adept seleccionar el archivo download.bit, que se encuentra en el directorio
Implementation del proyecto, y configurar la FPGA (este paso se realizara en caso de persistencia del
error en el paso anterior)

Una vez configurada la FPGA deberia verse en la terminal el siguiente mensaje:
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[2_\ Problems E,Tasks El Console | 2 Properties j.& 1l IS | l UE| 4 4 =B
Serial: (COM3, 9600, 8, 1, Mone, Mone - CONMECTED) - Encoding: (IS0-8859-1)
--Starting Memory Test Application-- -

MOTE: This application runs with D-Cache disabled.As a result, cacheline requests will not be generated

Testing memory region: micron_ram
Memory Controller: xps_mch_emc
Base Address: @x23000000
Size: @x81088008 bytes
32-bit test: PASSED!
16-bit test: PASSED!
8-bit test: PASSED!
--Memory Test Application Complete--

Figura 1.18. Mensaje observado en la terminal

Conclusion

La herramienta Base System Builder se usa en XPS para generar un sistema basado en MicroBlaze junto
con una aplicacién de software para prueba. Se crean distintos archivos utilizados por las diferentes
herramientas de software necesarias para implementar el sistema en FPGA. Se utilizan distintas vistas para
acceder a la configuracion del sistema. Una vez configurado éste, se crean las netlists necesarias para la
implementacion. Una vez implementado el sistema, se agrega al bitstream la informacion necesaria para
inicializar la memoria de cédigo del procesador con la aplicacion de software.
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